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TeleFinder/User is the application that connects your Macintosh
to a TeleFinder bulletin board system (BBS).  TeleFinder/User
requires a color capable Macintosh, and Apple’s System 7.0 or
higher.  Through your TeleFinder/User-BBS interface, you’ll
find business services, customer support, as well as “friendly
chat.”  A BBS can also serve as a conference forum, provide
electronic mail service, and store files to be transferred.  The
individual or company operating the BBS (the sysop) determines
which services to offer its callers.  The Sysop also decides
whether the BBS  will be open to public use, or kept for private
use.

TeleFinder provides an easy to use interface to work with files,
mail and messages by simply clicking and dragging icons.  With
System 7.5, TeleFinder uses your Finder  desktop to provide
“drag-and-drop” file transfers.  With earlier system software
TeleFinder will emulate the Finder desktop to provide the drag-
and-drop capability.  TeleFinder also includes a text editor,
address book, and a mail outbox for automating the pickup and
delivery of mail.

The purpose of this section is to help you to get up and running
as quickly as possible.  The following steps outline the
procedures for installing and configuring TeleFinder/User.

Installing TeleFinder/UserInstalling TeleFinder/UserInstalling TeleFinder/UserInstalling TeleFinder/UserInstalling TeleFinder/User
Install and Open TeleFinder/User.

• With Finder, open the “TeleFinder™/User.sea” file.  Then
click on the "Continue" button in the opening window.

• Use the “Save” dialog to choose a location to install
TeleFinder/User.  This creates the “TeleFinder™/User " folder
on your hard disk.
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• Open the TeleFinder User application from inside the
TeleFinder/User folder.

Note: TeleFinder/User automatically opens the
Default Settings file and loads the saved configuration.
TeleFinder saves most configuration changes you
make in whichever settings file is currently open.  Use
the “Open” command from the File menu to choose a
different settings file.

Setting up the ConnectionSetting up the ConnectionSetting up the ConnectionSetting up the ConnectionSetting up the Connection
In this section you will configure TeleFinder/User with your
logon name, password, BBS phone number, and information
about your modem.

• Enter your logon name and password in the designated fields

•  •  •  •  •  If you are supporting dial-in access through your modem
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then you will configure using the “Modem” Connection Method.
For other connection methods please refer to the “Using Other
Connection Methods” section of this chapter.

• Click in the “Setup” button in the Connection window.
TeleFinder will open the “Modem Setup” dialog.

• Select the serial port your modem is connected to from the
serial ports list of the “Modem Setup” dialog.

• Scroll through the Modem Settings list, and click on the name
that most closely matches the name of your modem to select it.
The modem setup configures TeleFinder with settings to make
your modem work properly.

• Enter the telephone number of the BBS you want to connect to
in the “Telephone Number” text field.

Note: If you need to dial “9” to get an outside line,
enter it as “9,,” ( nine followed by two commas.  When
using calling cards, enter your calling card number in
along with the telephone number.  You may need to
separate the telephone numbers from the calling card
number with two or more commas.  Each comma tells
the modem to pause between the numbers.

• Click in the "OK" button to save the settings.  Click in the
Connect button to place the call.
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Connecting to a TeleFinder BBSConnecting to a TeleFinder BBSConnecting to a TeleFinder BBSConnecting to a TeleFinder BBSConnecting to a TeleFinder BBS
See the “Setting up TeleFinder” section if you need instructions
for setting the telephone number or choosing a modem
configuration.

TeleFinder dials the number using your modem and then waits
for the BBS Server to answer your call.  TeleFinder will
automatically make repeated attempts to connect to a busy line.
Click in the Cancel button to stop.

You normally see the following messages in the Call Progress
portion of the Connection window while TeleFinder is
connecting.

Opening the Connection…
Connection Established…

After the modems connect, TeleFinder logs you on to the bulletin
board.  This is when the bulletin board checks your name and
password.  The BBS starts this process.  You should see these
messages displayed in the dialer as log on takes place.

Waiting for the host…
Sending name and password…
Waiting for authorization…
Successful connection!

If the log on fails, it is usually because the modems did not make
a good connection.  Poor connections often result from using the
wrong settings.  Correct TeleFinder’s modem configuration if
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necessary.  Refer to the Trouble Shooting section of this manual
if you have problems connecting, or if your modem is not shown
in the Modem Setups list.

If your password is incorrect the BBS sends a message saying
that your name or password did not match.  If necessary, verify
the password and try again.

Registering with a BBSRegistering with a BBSRegistering with a BBSRegistering with a BBSRegistering with a BBS
If you are not yet a registered user of the BBS or if your logon
name is misspelled, your BBS will send you a message
explaining what to do next.   If you are already a user of the BBS,
correct the name and password in the Connection window  and
try again.  If you are a new user of the BBS, fill in the registration
form to request an account.
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Icons Received from the BBSIcons Received from the BBSIcons Received from the BBSIcons Received from the BBSIcons Received from the BBS
After a successful connection, TeleFinder displays the BBS
Desktop window with the icons you have access to.  Double-
click an icon to open it.

This screen is an example of what users see after connecting to
Spider Island Software’s BBS.  Bold icon names indicate new or
recently changed files.

TeleFinder displays file area icons to provide you access to
demo, shareware, and public domain software.  The Mailbox
icon contains your mail.  The Conferences icon contains message
topics with news, information and public discussions.  The
Upload Here! icon is used to send files to the BBS.  The BBS
system operator chooses the icons and names of BBS areas.

If an auto message was assigned to your access group it will be
automatically displayed.  You can save the document as a text
file or print it.  The Session Time window shows BBS connection
and time information.
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Folder Access PrivilegesFolder Access PrivilegesFolder Access PrivilegesFolder Access PrivilegesFolder Access Privileges
The icons in the upper left portion of windows describe the
access privileges you have within a given folder.  The BBS
system operator may assign you any combination of Write,
Delete, See Files and See Folders access.

The most common access within a “Files” folder is “No Write,
No Delete, See Files and See Folders.”  With these privileges you
can download the files contained within that folder but cannot
delete files, or add new files to the folder.

Conference areas access is usually : “Write, No Delete, See Files
and See Folders.”   With these privileges you can create new
topics within the conference and post your own messages to
existing topics.

Session Time WindowSession Time WindowSession Time WindowSession Time WindowSession Time Window
You can open the “Session Time” window by selecting the
“Session Time” command from the Special menu.  This window
displays a variety of useful information while your connected to
the BBS.

The Session Time window displays the following information.

BBS Node Name - “Spider Island Modem 1,” this is the name
assigned by the BBS operator to the node of the BBS you are
connected to.  On multi-line BBSes each Node will usually have
a different name.
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Connection Info - “•Modem, speed 14400 bps, connected.”  This
show that you’re modem is connected to the BBS at 14.4 kbps.

Time Connected - This displays the running total of hours,
minutes and seconds that you been connected for in the current
session.

Time Remaining - This shows how much longer you may be
connected for in the current session.  Since BBSes have a limited
number of modems most system operator impose “per logon”
time limits for each user.

Last Logon - This is the time and date of your last connection to
the BBS.

Host Time - This is the local time and date at the moment of
your connection to the BBS.

K’s Downloaded - This is the cumulative number of kilobytes
that you’ve downloaded from the BBS.

Receiving FilesReceiving FilesReceiving FilesReceiving FilesReceiving Files
To receive a file you simply drag the file to wish to receive to
your hard drive icon.   To receive a file in an area other than the
root level of your hard drive, open the hard drive icon first and
maneuver to the folder you wish to place the file, and drag the
file directly to that folder.

Batch File TransfersBatch File TransfersBatch File TransfersBatch File TransfersBatch File Transfers
You can send or receive a group of documents at the same time.
Select the icons identifying the group of files.  Then drag them to
their destination.  You can select them all at once by drawing a
selection rectangle around them, or individually by holding the
shift key down while you click on individual icons.
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Use the File Basket when you want to make batch transfers from
separate locations.  First put the different files into the File
Basket, then make the batch transfer from the File Basket to your
hard disk.

Sending Files to the BBSSending Files to the BBSSending Files to the BBSSending Files to the BBSSending Files to the BBS
Drag a file’s icon to the Upload icon in the BBS Desktop window.
That is all that is necessary to begin a file transfer using
TeleFinder.  After the transfer is complete, there will be an exact
copy of the file on the BBS’s hard disk.  The BBS Sysop decides
which folder uploads go into using  access group settings.

You can also transfer files directly to a “Files” area when you
have “Write” privileges in that area.

File Transfer ProtocolsFile Transfer ProtocolsFile Transfer ProtocolsFile Transfer ProtocolsFile Transfer Protocols
TeleFinder supports ZMODEM , XMODEM-CRC, and
XMODEM-1K file transfers, in addition to a “Background”
protocol using TeleFinder’s native communications facilities.
Select the file transfer protocol you wish to use from TeleFinder’s
Special Menu.

Each of TeleFinder’s file transfer protocols provide error
correction using advanced error detection techniques to insure
accurate data transfer.

The Background transfer protocol lets you continue to use the
BBS while transfers are in progress.  You can also send and
receive files at the same time.  This is the preferred protocol
because of it’s combination of speed and convenience.

ZMODEM file transfers have the advantage of 32-bit CRC’s and
file recovery.  If a ZMODEM file transfer fails to complete,
TeleFinder saves the part of the file already received.  You can
then complete the transfer either on another call, or during the
same call.  Just drag the file to the same location to continue the
transfer where it left off.
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TeleFinder/User supports the “streaming” and “windowed”
ZMODEM variations.  Use streaming to get the fastest file
transfers.  Use windowed when there is a flow control problem.
Switching to windowed ZMODEM can be helpful if you notice a
large number of retransmits.

The XMODEM file transfer protocol does not require flow
control and has less overhead than ZMODEM.  Use XMODEM
when you have small files to transfer, or when you have
problems with flow control.  XMODEM does not support file
recovery.

ZMODEM Partial FilesZMODEM Partial FilesZMODEM Partial FilesZMODEM Partial FilesZMODEM Partial Files
Select the “Show Partial Files” command from the Special menu
to display a list of partially completed file transfers.  This is the
list that TeleFinder uses to make it possible to resume
interrupted file transfers.

This window shows the location of partially completed transfers,
what BBS they come from, and how much of the file has been
transferred.

TeleFinder will keep no more than 50 entries in this list, and the
oldest items will be removed to make room for new items when
a ZMODEM file transfer is interrupted.  You can remove items
manually from the list using the Trash button.
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Using the File BasketUsing the File BasketUsing the File BasketUsing the File BasketUsing the File Basket
TeleFinder’s File Basket is the best way to keep track of files that
you might want to download later.

To use the File Basket  just drag a file’s icon to the File Basket
window.  TeleFinder will create it’s own alias of the file in the
File Basket window.

File Basket aliases support all of TeleFinder’s file operations.
You can use them to transfer, view, open and get file
information.

Viewing the File Basket by Thumbnail lets you easily compare
images and file descriptions.

Downloading from the File BasketDownloading from the File BasketDownloading from the File BasketDownloading from the File BasketDownloading from the File Basket
You can just drag files from the File Basket to your hard disk as
you would from any folder.

TeleFinder will also prompt you to download files in your File
Basket before you disconnect.  If you choose Yes, TeleFinder will
download all the files in the File Basket, then disconnect.

Files can be removed from the File Basket by dragging files to
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the trash can. Files that are dragged from the File Basket to the
trash can are not deleted from the BBS, only removed from your
File Basket.

Using BBS Find FileUsing BBS Find FileUsing BBS Find FileUsing BBS Find FileUsing BBS Find File
BBS Find File quickly searches selected parts of the BBS for a file.
Select the “BBS Find File” command from the Special menu.
TeleFinder opens the window below.

• Select the part of the BBS you want to search from the “Search”
pop-up menu.  Every BBS icon that you have access to appears
in this menu.

• Choose the “Name Contains” if you know part of the name of
the file that you are looking for. Enter the part you know in the
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field to the right of the menu. If you enter partial strings ( ie: Tele
Demo ) the file’s name matches when it contains both strings ( ie:
TeleFinder Demo would match, TeleFinder.cpt would not )

• Choose the type of item you are looking for.

• Enter date criteria when you are looking for new files, old files,
or files last modified on a separate date. Choose “any date” to
broaden the search to include more possible matches.

• Click in the “Find” button to begin the search.

TeleFinder builds a list of the files and folders it finds.

Working with Found FilesWorking with Found FilesWorking with Found FilesWorking with Found FilesWorking with Found Files
Once the search is complete, you can open, and get information
about, the files TeleFinder finds.

• Select a file or folder from the list.

• Click in the Open button to display e-mail, text, graphics and
message topics.  If TeleFinder cannot display the type of file
selected in the list, the Open button will display the Info
window.

• Click in the Receive button to begin the transfer of the selected
file to your Macintosh.
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Using File InformationUsing File InformationUsing File InformationUsing File InformationUsing File Information
Select a file icon, then select “Get Info” from the File menu.
TeleFinder displays the file’s name, size, and the date it was
created and last modified in the “Info” window.  A description
of the file and preview picture may also be present.

Click on the “Receive” button to transfer the file to your
“Receive folder.”  The file transfer process begins immediately.

Note: You can also drag the file’s icon to a specific
folder to transfer it to that location, or the File Basket
window to save it for later transfer.

Using “By Thumbnail” Folder ViewUsing “By Thumbnail” Folder ViewUsing “By Thumbnail” Folder ViewUsing “By Thumbnail” Folder ViewUsing “By Thumbnail” Folder View
TeleFinder’s “By Thumbnail” view is the best way to browse



TeleFinder User for Macintosh page  15

files that contain textual descriptions and preview pictures.

.

To use the thumbnail view select the “By Thumbnail” Option
from the Windows menu.  TeleFinder will then display the file
folder as shown above.

Continue to use the file’s icon for drag and drop even while in
the “By Thumbnail” view.  It is not necessary to switch back to
“By Icon” view to start file transfers.

Viewing GraphicsViewing GraphicsViewing GraphicsViewing GraphicsViewing Graphics
TeleFinder supports graphics viewing both on, and off-line.  The
types of graphics files supported are: GIF ( Graphics Interchange
Format ), PICT (␣ Macintosh picture format ), and JPEG
compressed pictures ( requires QuickTime 1.0 or better ).

Open the graphics file icon to view the file while on-line.  Use
the “Open…”  command from the File menu to open a file from
your Hard Disk.
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The GIF format has several advantages for on-line viewing.

- GIF uses lossless compression to keep file size small without
sacrificing image quality.
- GIFs can be “interlaced” which lets you see the full picture
sooner.
- GIF supports up to 8 bit color and custom palettes.

Using E-MailUsing E-MailUsing E-MailUsing E-MailUsing E-Mail
When mail is waiting the mailbox icon shows a letter sticking
out of it.  No letter means there are no files in your mailbox.
Mail remains in your mailbox until you drag it to the Trash icon
to remove it.

Your mailbox can contain messages, files, and folders.  You can
read the messages by double clicking on their icons.
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Your mailbox may contain three special folders; Attachments,
Pub, and Web Space.

The “Attachments” folder will contain files that are received
accompaning an e-mail message.  Attachments can be
downloaded from the message itself, or directly from the
Attachments folder.

The “Web Space” folder is accessible via the HTTP protocol,
which is used by the World-Wide Web and internal “intranet”
networks.  See the section “Using the Web Space Folder” for
additional information on this folder.

The “Pub” folder contains special files such as your profile and a
mail forwarding file.  See the section “Using the Pub Folder” for
additional information on this folder.

Sending E-MailSending E-MailSending E-MailSending E-MailSending E-Mail
You can use TeleFinder’s e-mail to exchange messages and files
between users of the bulletin board system, and through
gateways to other mail systems.  TeleFinder provides you with a
mail form to compose and send messages.

TeleFinder/User also includes a Mail Outbox that you can use to
prepare mail off-line.  You can send messages from the Mail
Outbox at a chosen time, during a connection, or immediately.

Composing MessagesComposing MessagesComposing MessagesComposing MessagesComposing Messages
You can use the mail form to compose messages up to 32K in
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size.  You can also attach files of any size to the message.  The
mail form uses standard Macintosh editing commands.  You can
import text into a mail form from existing documents.  You can
also use TeleFinder’s text editor to compose a message using
parts of other text documents.  For more information on working
with text, please see the “text editing and printing” section.

Addressing MessagesAddressing MessagesAddressing MessagesAddressing MessagesAddressing Messages
Within the BBS, TeleFinder uses your logon name as your e-mail
address.  Through mail gateways, TeleFinder uses domain
addressing in the format “user_name@domain.”  Addresses are
not case sensitive.  You can address a message using any one of
the following three methods:

Method 1:Method 1:Method 1:Method 1:Method 1:
Use the address TeleFinder provides by replying to a message.

• Open mail another user sent to you.

• Click in the message’s “Reply” button, or select the “Reply to
Mail” command from the mail menu.  TeleFinder will open a
properly addressed mail form.

Method 2:Method 2:Method 2:Method 2:Method 2:
Select an Address from the Address Book
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• Select the “New Mail Form” command from the mail menu.
TeleFinder will open a mail form that contains your logon name
in the “From” text box.

• Click in the “To” button at the top of the window.  TeleFinder
will open a dialog containing a list of all the names in your
address book.

• Select a name from the list.

• Click in the “OK” button to address the message.

Method 3:Method 3:Method 3:Method 3:Method 3:
Type a name into the “To” text box.

• Type or  paste the user’s name in the “To” text box.

After addressing the e-mail, compose your message.  Then click
in the Mail button to send the message.

Using Locate a UserUsing Locate a UserUsing Locate a UserUsing Locate a UserUsing Locate a User
Use “Locate a User” to learn the correct names of other users of
the BBS.

• Select the “Locate a User” command from the Mail menu.  This
opens the Locate dialog.

• The enter a part of the user’s name in the dialog’s text box.
Leave it blank for a list of all the BBS users.

• Click in the OK button to begin the search.  TeleFinder will
display a User List containing all of the matching names.
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Addressing to Multiple UsersAddressing to Multiple UsersAddressing to Multiple UsersAddressing to Multiple UsersAddressing to Multiple Users
• Separate each name and/or address by using a comma.

Note: You can freely mix the addresses of users
reached via gateways and local BBS user names.

File AttachmentsFile AttachmentsFile AttachmentsFile AttachmentsFile Attachments
File attachments are a convenient way to send files to other
people.  You can attach multiple files to your messages.  When
you Mail the message TeleFinder sends the files to the BBS
where they will be processed and distributed.

Files that will be routed through an Internet or Server to Server
gateway will be converted to an Internet format before they are
transmitted.  As a user this process is transparent and automatic,
the TeleFinder Server does all the necessary processing and
encoding.

The reverse is true when receiving files from a person through a
gateway.  In this case the TeleFinder Server will convert the
attached files from the Internet format back into a usable
Macintosh or DOS file.

Attaching Files to a MessageAttaching Files to a MessageAttaching Files to a MessageAttaching Files to a MessageAttaching Files to a Message
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• Click in the “Attach” button on the Mail form. TeleFinder will
open the “Open” dialog.

• Use the “Open” dialog to locate and select the file you wish to
attach to the message.

• Click in the “Open” button.  TeleFinder will add the file to the
attachments list.

Removing AttachmentsRemoving AttachmentsRemoving AttachmentsRemoving AttachmentsRemoving Attachments
• Select it’s name in the list by clicking on it.

• Hit the “delete” key or select the “Clear” command from the
Edit Menu.

Receiving a File AttachmentReceiving a File AttachmentReceiving a File AttachmentReceiving a File AttachmentReceiving a File Attachment
When another person sends you mail that includes attached files
TeleFinder will display the file names in the attachments list.

Select the file’s name from the list, then click in the “Receive”
button to begin transferring the file to your hard disk.

TeleFinder will put a copy of the file into the default receive
folder.  You can set this using the “Set Receive Path” command
from the File menu.
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Maintaining the Address BookMaintaining the Address BookMaintaining the Address BookMaintaining the Address BookMaintaining the Address Book
TeleFinder’s address book stores a person’s e-mail address and,
optionally, their names.  Follow the instructions below to add a
user’s name to the Address Book.

• Select the “Open Address Book” command from the mail
menu.  TeleFinder displays the names of the users in your
address book in the Addresses window.

• Click in the “Add” button to add a name to the list.  TeleFinder
opens the “User Address” dialog.

• Enter the e-mail address and name into the dialog’s text boxes.
You can enter up to 255 characters each the e-mail and name text
box.  As shown above, you can enter any informative text into
the name field.

• Click in the “OK” button to add the name to the address book.

You need to select a name from the list in the “Addresses”
window before you can use the other buttons.  They perform the
following functions:
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- Mail Form: Click on this button to open an addressed Mail
Form to compose e-mail.

- Mailbox: Click on this button when you are on-line to get
the drop-box icon of a local BBS user.

- Add: Click on this button to add an entry to the address
book.

- Change: Use this to change the e-mail address or name.

- Remove: Use this to remove a name from your address
book.

Using the Mail OutboxUsing the Mail OutboxUsing the Mail OutboxUsing the Mail OutboxUsing the Mail Outbox
You can use the Mail Outbox to automatically pick up and
deliver mail.  Compose and address your messages, then add
them to the Mail Outbox for later delivery.  You can queue up to
250 messages in the Mail Outbox.

You can use the Mail Outbox to send messages at a later time, or
upon demand.  In either case, TeleFinder/User needs to be open
at the time you want to send the mail.

Adding Files to the Mail OutboxAdding Files to the Mail OutboxAdding Files to the Mail OutboxAdding Files to the Mail OutboxAdding Files to the Mail Outbox
The following steps explain how to add a message to the  Mail
Outbox.

• Compose and address a message using TeleFinder’s Mail
Form.

• Use the “Save as…” command from the file menu to save the
message on your hard disk.
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Save messages you want to send later as “E-Mail” files.
Be sure that the “E-Mail” button is selected in the
“save” dialog.

• Choose the “Open Mail Outbox” command from the Mail
menu.  TeleFinder will open the “Mail Outbox” window.

• Click in the “Add” button to select the message you previously
saved.  TeleFinder will open the “Open” dialog box.

• Use the “Open” dialog to navigate to the message.  Select the
message you wish to send from the list in the dialog box.

• Click in the “Open” button.  TeleFinder then adds the file and
user name to the list in the Outbox window.

If you want TeleFinder/User to download any mail
waiting in your mailbox, turn on the “Pick up my mail
too!” checkbox.
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Adding E-Mail directly to the Mail OutboxAdding E-Mail directly to the Mail OutboxAdding E-Mail directly to the Mail OutboxAdding E-Mail directly to the Mail OutboxAdding E-Mail directly to the Mail Outbox
The TeleFinder mail form includes a “Mail Later” button. After
you’ve finished composing a message, use this button to add the
message directly to the outbox.

Selecting a Time to SendSelecting a Time to SendSelecting a Time to SendSelecting a Time to SendSelecting a Time to Send
After selecting the messages you want to send, you can choose to
send them now, during the next connection, or at a specific time.

Sending NowSending NowSending NowSending NowSending Now
Click in the “Send Now” button to send the files now.
TeleFinder will connect to the BBS, transfer the files, then hang
up.  TeleFinder uses the settings in the Auto Dialer window to
make the connection.

Sending at the Next ConnectionSending at the Next ConnectionSending at the Next ConnectionSending at the Next ConnectionSending at the Next Connection
Click in the “Next Connect” button.  After you connect to the
BBS, and select the “Quit” or “Hang Up” command, TeleFinder
will check the Outbox.  If there are files ready to send,
TeleFinder will ask whether or not to send them.

Sending at a Specific TimeSending at a Specific TimeSending at a Specific TimeSending at a Specific TimeSending at a Specific Time
• Click the “Send Files At” button to set a time for sending.
TeleFinder will open the “Date/Time Set” dialog.



page  26

• In the dialog, enter the time and date you want TeleFinder to
send the files.

• Click in the “OK” button to save the time setting.  When
TeleFinder is open, it will check to see if it is time to send files.
When that time passes, TeleFinder uses the settings in the Auto
Dialer window to connect to the BBS.  Then it transfers the files
and hangs up.

Using Message TopicsUsing Message TopicsUsing Message TopicsUsing Message TopicsUsing Message Topics
The message viewer window contains buttons to select a
message, reply to a message, and remove a message from a
topic.  You can also print messages, and save messages as text
files, using commands in the File menu.

Note: Only the Sysop, topic administrator, or the
person who originally posted a message can remove a
message from a topic.

Selecting MessagesSelecting MessagesSelecting MessagesSelecting MessagesSelecting Messages
When you first open a topic, TeleFinder automatically  displays
a message in the viewer window.  TeleFinder selects this
message based on the date you last read messages.

You can select a specific message by its number or post date.
You can also select messages from a list of message subject
headers.
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Click in the “Right Arrow” button to view  new messages by
post date.  Click in the “Left Arrow” button to view  previous
messages in descending order by date.   The current message
number is shown between the arrows.

Selecting By NumberSelecting By NumberSelecting By NumberSelecting By NumberSelecting By Number
Use “Select By Number” to select a message by its message
number.  This method  is useful when you want to skip to the
end, or start over at the beginning, of a topic.

• Click in the “By Number”  button.  TeleFinder will open the
“Get Message” dialog.

• Enter the number of the message you want to see in the
dialog’s text box.

• Click in the “OK” button.  TeleFinder will display the message
associated with that number in the viewer window.

If the message number that you enter is higher than the number
of messages in the topic,  TeleFinder will display the topic’s last
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message.

Selecting By DateSelecting By DateSelecting By DateSelecting By DateSelecting By Date
Use “Select By Date” to select a message by its post date.  This
method is useful when you want to find a message that was
posted around a given date.

• Click in the “By Date”  button.  TeleFinder will open the
“Date/Time Set” dialog.

• Enter a date and time in the dialog.

• Click in the “OK” button.  TeleFinder will then display the
message that has a post date closest to the date you specify.

TeleFinder will display the topic’s last message if the date you
provide is greater than the post date of any message in the topic.
TeleFinder will display the topic’s first message if the date you
provide is earlier than the post date of any message in the topic.

Selecting Messages from a ListSelecting Messages from a ListSelecting Messages from a ListSelecting Messages from a ListSelecting Messages from a List
Use “Select From List” to view a list of message headers.  A
message header includes the To, From, Subject, and Post Date
information from a message.  This method is useful when you
want to scan a topic for messages about specific subjects.

• Click in the “From List” button.   TeleFinder will open the “Get
Message” dialog.

• In the dialog’s text box, enter the number of the first message
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you want to appear in the list.

• Then click in the “OK” button.  TeleFinder will open the “Scan
List” window and display messages from the specified start
point till the end of the topic.

• Select a message header from the list.  Then click in the
“Open” button.  TeleFinder will then bring the message viewer
window to the front, and display that message.

Replying to MessagesReplying to MessagesReplying to MessagesReplying to MessagesReplying to Messages
Replies to messages can be public  or private.  TeleFinder sends
private replies as e-mail to the user’s mailbox.   TeleFinder adds
public replies as a new message in the topic.  You compose both
types of replies using the reply window.  Follow the steps below
to reply to a message.

• Click in the “Reply” button to open a reply window.
TeleFinder addresses the reply using information from the
message viewer window.
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TeleFinder’s Topics also support file attachments.  Just
click in the “Attach” button to add files to the
attachments list.

• If necessary, change the “Subject” and “To” fields.

To  –- Use this to address your reply to a different person.
Subject –- Enter new text to describe the subject of your

message here.

• Click in the “Post” button add the message to the topic.

• Click in the “Mail” button to send the message to the
addressee’s mailbox.

Creating a New TopicCreating a New TopicCreating a New TopicCreating a New TopicCreating a New Topic
Users with the appropriate access privileges can create new
topics in Conference folders.  A user needs to have either the
global “Can Make Changes” Sysop  privilege, or the “Can create
topics” path privilege to be able to create new topics.   To create
a new  message topic, follow the steps below.

• Bring a conference window to the front of the screen.
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• Then select the “New Topic in  ‘window’” item (“Sysop’s
Corner” in this example) from the Mail menu.  This will open a
message reply window  as shown below.

• Address the message to a specific user, or generically to
“ALL.”

• Enter a subject name in the subject text box.  The name  you
enter becomes the name of the topic icon in the conference you
are creating the topic in.

• After composing your message click in the “Post” button.
TeleFinder then sends the message and creates the topic icon in
the conference window.

Subscribing to TopicsSubscribing to TopicsSubscribing to TopicsSubscribing to TopicsSubscribing to Topics
Use TeleFinder’s Subscribe to Topic feature to keep a copy of the
messages in a topic on your own hard disk. You can then read
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and reply to messages even when you’re off-line.

Follow these steps to start a subscription:

• Connect to a TeleFinder BBS.
• Open the conference folder containing the topic you want to
subscribe to.
• Select the topic icon.
• Then select “Subscribe to Topic” from the “Mail” menu.

TeleFinder will then download the messages and make an entry
for the topic in TeleFinder’s Topic Inbox. You’ll see each
message appear on your screen as TeleFinder saves them.

Opening the Topic InboxOpening the Topic InboxOpening the Topic InboxOpening the Topic InboxOpening the Topic Inbox
From the “Mail” menu select the “Open Topic Inbox” command.
TeleFinder will display a list of topics you subscribe to.

The list shows the name of the topic, the source BBS, the date
TeleFinder last updated the topic, and the update frequency
option.

Topic Update FrequencyTopic Update FrequencyTopic Update FrequencyTopic Update FrequencyTopic Update Frequency
TeleFinder sets new subscriptions with a daily update
frequency. This means that TeleFinder will request new
messages from the BBS and send messages you post just once
per day. TeleFinder updates topics when you connect to the
source BBS just after the BBS icons appear on your screen.

Use the Options button to change the update frequency to each
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call or put the subscription on hold.

When the subscription is on hold TeleFinder will only update
the topic when you use the Update button. You can use the
Update button to update the topic manually. You need to be on-
line to update a topic.

Removing a Topic SubscriptionRemoving a Topic SubscriptionRemoving a Topic SubscriptionRemoving a Topic SubscriptionRemoving a Topic Subscription
Use the “Delete” button to remove a topic from the subscription
list. To reclaim disk space you need to delete the topic icon and
it’s message folder. The topic icon and message folder are in the
Incoming Topics Folder. The Incoming Topics Folder is in the
same folder as TeleFinder.

Restoring a Topic SubscriptionRestoring a Topic SubscriptionRestoring a Topic SubscriptionRestoring a Topic SubscriptionRestoring a Topic Subscription
You’ll need to restore a subscription if any one of the three
events occur:

• If you rename your settings file. TeleFinder uses this name to
indicate which service you’ve connected to.

• If the BBS sysop moves or renames the original topic. If the
sysop renames the topic, you should also rename the topic icon
in the Incoming Topics Folder.

• If the BBS sysop reformats the BBS hard disk.

You can restore subscriptions by re-subscribing to them. Just
repeat the original subscription steps. TeleFinder will not
download messages that are already in your Incoming Topics
Folder, it will just download new messages.

Using Multi-User ChatUsing Multi-User ChatUsing Multi-User ChatUsing Multi-User ChatUsing Multi-User Chat
Multi-User chat provides allows users to participate in chat
rooms where many users can chat together.
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Chat rooms appear in your BBS Desktop window just like other
areas of the BBS do.  The “Chat Room” icon above shows the
default icon for chat rooms.  Sysops can assign any icon to a chat
room.

This is the chat room window.  Messages you enter appear along
with the messages from users in the room.  You can enter up to
1K of text to send in this window.  The "In" and "Out" status
lines show you when users enter and leave the room.

To send a message, type text into the window.  All typed
characters will appear in the lower half of the window.  Press
‘return’ or ‘enter’ to send the text.  Your message will appear in
the upper half of the message, just as other users will see it.
Messages typed by other users will also appear in the upper half
of the window.

There are three pop-up menus in the lower left corner of the
Chat window, Options, Filters, and Hilites.

The first pop-up menu, the Options pop-up, allows you to
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customize the chat window.  The first option specifies whether
the text input area of the chat window appears at the top or the
bottom of the chat window.  The default is to appear at the
bottom of the chat window.  The second option specifies
whether voices are on.  Voices allow chat messages to be spoken
when they appear in the chat window.  To customize voices, see
the section “Chat User Profiles”.

The second pop-up menu, the Filters pop-up, allows you to filter
specific users.  A user that is filtered will not have their chat
messages displayed in your window.  This can be a way of
ignoring a user who is being annoying, or just a way of ignoring
users if the chat room is very busy.  Choose “Reset Filters” to
make all user’s messages visible.

The third pop-up menu, the Hilites pop-up, allows you to hilite
specific users.  A user that is hilited will have their messages
appear more prominently than other users.  It can be a way of
bringing greater attention to specific users that you are
conversing with.  See the section “Chat User Profiles” to specify
exactly how hilited user messages appear.  Choose “Reset
Hilites” to eliminate all hiliting from users.
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Chatting with the SysopChatting with the SysopChatting with the SysopChatting with the SysopChatting with the Sysop
Select the “Chat with Sysop” command from the Chat menu to
have a private chat with the BBS operator.  If the operator is not
available, you may receive a message back stating so.

You can use Chat anytime you are on-line.  Chat is possible
during Background file transfers but not during ZMODEM file
transfers.

To send a message, type text into the window.  All typed
characters will appear in the lower half of the window.  Press
‘return’ or ‘enter’ to send the text.  Your message will appear in
the upper half of the message, just as the Sysop will see it.  If the
Sysop is available, anything typed by the Sysop will also appear
in the upper half of the window.

The “Options” pop-up menu in the lower left corner of the chat
window works as described in the section “Using Multi-User
Chat.”
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List of Users On-LineList of Users On-LineList of Users On-LineList of Users On-LineList of Users On-Line
Select the “List of Users On-line” command when you are on-
line to produce a list like this. This list does not update itself, so
its “Update List” button to get a current listing.

- Use the “Mail Form” button to pop open an addressed mail
form to the selected user.

- Use the “Mailbox” button to get the “Drop-box” for the
selected user.

- Use the “Instant Message” button to open a window that will
allow you to chat specifically with a user.

- Use the “View Profile” button to open a window displaying
information about the user.  The user must create a profile for
this information to be available.  See the “Using the Pub Folder”
section for information on how to create a profile.

- Use the “Update List” button to refresh the listing of users
online.
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Instant MessagesInstant MessagesInstant MessagesInstant MessagesInstant Messages
Instant Messages are a way for two users to chat privately
without being in a chat room.  When you click in the “Instant
Message” button, you’ll a chat window that can be used to chat
with the selected user.  The user will automatically receive your
messages, and that user can choose to chat with you, or ignore
your messages.

The “Options” pop-up menu in the lower left corner of the chat
window works as described in the section “Using Multi-User
Chat.”

Instant messages can be sent to you as long as you are available
for Chat.  By default you are.  To make yourself unavailable for
Chat, deselect the “Available for Chat” option from the Chat
menu.
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Chat User ProfilesChat User ProfilesChat User ProfilesChat User ProfilesChat User Profiles
TeleFinder gives you complete control over how messages
appear in any of the Chat windows.  (ie: Multi-user chat, Chat
with Sysop, Instant Messages).  The customization for individual
users can be found by choose “Chat User Profiles” from the Chat
menu.

To add a new profile for a user, click in the “Add” button.  To
modify a profile for an existing user, select a name and click in
the “Change” button.  To delete a profile from the list, select a
name and click in the “Remove” button.

There are three “special” users; Default User, Hilited User, and
Self.  These profiles can not be removed, but they can be
modified.  They’re use is as follows:

Default User - applies to messages that appear from
any user that does not have a specific profile setup.

Hilited User - applies to any user that does not have a
custom profile and has been hilited using the Hilite
pop-up menu.  See the section “Multi-User Chat” for
information about hiliting.

Self - applies to messages from yourself.

The following is the window used for editing a chat user profile:
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In the “User Info” section, enter the user’s name in the “Name”
field.  This field can not be modified for specials users; default,
hilited, or self.

In the “Name Appearance” section, specify how a chat window
will display the user’s name.  The font, size, color, and style
attributes can be specified.

In the “Message Appearance” section, specify how a chat
window will display the user’s text.  The font, size, color, and
style attributes can be specified.

In the “Voice Characteristics” section, specify what voice will be
used be used for this user when “Voices On” is selected in a Chat
window.  A specific voice can be chosen, and the rate and pitch
of the voice can be specified.  Use the audio button to hear a
sample of the voice.  In order to support voices, Apple’s
Plaintalk must be installed.
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Changing your PasswordChanging your PasswordChanging your PasswordChanging your PasswordChanging your Password
Select “Change Password” from the Special menu to change
your user password.  This option must be performed while
connected to the BBS.

The password must be between 4 and 9 characters.  Use the
“Peek” button to see what the password is after you’ve typed it.

Changing the password will change the password that is stored
on the BBS.  It does not change the password in your settings
file, so you must do that the next time you connect to the BBS.

Disconnecting from a BBSDisconnecting from a BBSDisconnecting from a BBSDisconnecting from a BBSDisconnecting from a BBS
Select “Disconnect” from the Special menu.  This command logs
you off from the BBS, then tells the modem to disconnect from
the line.

Text Editing and PrintingText Editing and PrintingText Editing and PrintingText Editing and PrintingText Editing and Printing
TeleFinder has a built-in text editor to create, print, and edit
documents using styled text. You can open a text document from
a local disk at any time.  You can open text documents from the
BBS while you are on-line.  You can not edit BBS documents
until you save them on your own disk.

Creating New DocumentsCreating New DocumentsCreating New DocumentsCreating New DocumentsCreating New Documents
To open an untitled document, select the “New Text” command
from the File menu.  This opens an untitled text editor
document.  The text editor supports the standard menu
commands in the Edit and File menus.   The text editor also
supports the “Import Text” and “Special Import” commands in
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the file menu.

Opening Existing DocumentsOpening Existing DocumentsOpening Existing DocumentsOpening Existing DocumentsOpening Existing Documents
You can open text documents using the “Open” dialog.

• Select the “Open…” command from the File menu.
TeleFinder displays the “Open” dialog.

• Select a file from the “Open” dialog.

• Click in the dialog’s “Open” button.  TeleFinder then opens
the document in a text editor window.

Using Special KeysUsing Special KeysUsing Special KeysUsing Special KeysUsing Special Keys
The text editor supports movement of the insertion point using
keyboard commands.  The e-mail and topic reply windows also
support these commands.

• Use the “Up Arrow” key to move the insertion point up one
line.

• Use the “Down Arrow” key to move the insertion point down
one line.

• Use the “Left Arrow” key to move the insertion point left one
character.

• Use the “Right Arrow” key to move the insertion point right
one character.

Holding down the Option key while using the arrow keys
magnifies the movement of the insertion point.

• Use the “Home” key, or type “Option+Up Arrow”, to move
the insertion point to the top of the document.

• Use the “End” key, or type “Option+Down Arrow”, to move
the insertion point to the end of the document.

• Type “Option+Left Arrow” to move the insertion point to the
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beginning of the line.

• Type “Option+Right Arrow” to move the insertion point to the
end of the line.

The “Page Up” and “Page Down” keys scroll the document
without changing the insertion point.  The “Enter” key scrolls
the document to make the insertion point visible.

Importing TextImporting TextImporting TextImporting TextImporting Text
The “Import Text” and “Special Import” commands merge text
into your e-mail, topic reply, or text documents.  Merging text
takes the text of an existing file and adds it to another document.
The new text is added at the insertion point, replacing any
selected text.

• Use the “Import Text” command to merge a file without
filtering.

• Use the “Special Import” command to filter the text in a file
before merging it.  Filtering strips unused control characters and
hard returns as it merges text.  This process promotes better
word-wrapping and cleans up files originating from DOS.

Composing Messages with Styled TextComposing Messages with Styled TextComposing Messages with Styled TextComposing Messages with Styled TextComposing Messages with Styled Text
You can apply Font, Size, Style, and Color attributes to the text
in e-mail, public messages, and text documents.  TeleFinder is
“WorldScript” compatible so using Japanese  and other multi-
byte fonts like “Osaka” is as simple as using ASCII fonts like
“Helvetica.”

Automatic Message ClosingAutomatic Message ClosingAutomatic Message ClosingAutomatic Message ClosingAutomatic Message Closing
TeleFinder automatically inserts the contents of the file named
“MessageClosing.txt” each time you open a "New Mail Form" or
reply to an existing message.  Customize this file to include your
name and a "stock" message closing and choice of default font/
style for your messages.  Delete the file if you don't want
automatic closing insertion.
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You can make this file using TeleFinder’s text editor.  It must be
in the same folder as TeleFinder/User.

PrintingPrintingPrintingPrintingPrinting
You can print text documents at any time except during a file
transfer.

The BBS may disconnect you if a document takes more than a
few minutes to print.  It is better to print while you are off-line,
or to print only small documents while you are on-line.

To print a document, use the “Chooser” Desk Accessory to select
the printer you want to use.  Then  select the “Page Setup”
command from the File menu.  This opens a common dialog to
select options supported by your printer.

Select the “Print” command from the File menu to prepare and
send the document to the printer.  TeleFinder prints your
document using the same Font that is used to display it on the
screen.
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Using the Web Space FolderUsing the Web Space FolderUsing the Web Space FolderUsing the Web Space FolderUsing the Web Space Folder
The “Web Space” folder may automatically appear in your
mailbox if the Sysop has configured your account to be able to
publish HTML pages.  Contents of the Web Space folder are
accessible via the HTTP protocol, which is used by the World-
Wide Web and “intranet” networks.

To publish a homepage from this folder, upload a valid HTML
file with the name “homepage.html” to the Web Space folder.
Graphic files such as GIFs and JPEGs may also be uploaded to
this folder.

The URL for the homepage will be based on the hostname of the
BBS.  For example, at Spider Island, John Smith’s homepage can
be found at http://www.spiderisland.com/~john_smith/
homepage.html.  The “homepage.html” may be usually be
omitted, so the URL would be http://www.spiderisland.com/
~john_smith/.  Check with the Sysop for information on what
the default home page should be named.

Using the Pub FolderUsing the Pub FolderUsing the Pub FolderUsing the Pub FolderUsing the Pub Folder
The “Pub” folder contains special files such as your “Profile”
and a “Forward” file.  If this folder does not exist, it can be
created by choosing “New Folder” from the File menu.  The two
files are discussed below:

Profile - A text file called “Profile” may be uploaded to the Pub
folder.  This text file will be viewable by other users and should
be used to describe yourself.

The Profile can be created within TeleFinder/User by choosing
“New Text” from the File menu.  The contents of the Profile are
accessible when a user selects the “View Profile” button in the
List of Users Online window.  The contents can also be retrieved
on the Internet using the “Finger” protocol if the Sysop allows
this feature.

Forward - A text file called “Forward” may be uploaded to the
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Pub folder.  This text file allows you to have your e-mail
forwarded to another Internet address.  This feature may not be
available, so check with your Sysop to determine if this is
allowed.  The Forward file is a text file that contains e-mail
addresses separated by a comma.  For example:

chris@spiderisland.com, rusty@spiderisland.com,
jose@spiderisland.com

The Forward file may contain your name listed so that you will
receive a copy of the message in your mailbox.  If your own
name is not included in the Forward file, the e-mail will be
forwarded to the destination and not delivered to the BBS.

PreferencesPreferencesPreferencesPreferencesPreferences
TeleFinder/User can be customized by choosing “Preferences”
from the Edit menu.  The preferences window had four panels
that are discussed below.

The “General” panel contains five options.

Open the connection window on startup - If this option is ON,
TeleFinder/User will open the “Connect” window automatically
when the program is first started.

Save Password - If this option is ON, TeleFinder/User will save
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the user password to the current settings file whenever a
connection is made to a BBS.  If this option is OFF, the password
will not be remembered.

Remind me to save messages I read - If this option is ON,
TeleFinder/User will prompt you to save an e-mail message if
you have not already done so, when you close an e-mail
window.  If this option is OFF, you will not be prompted.

Remind me to post to message topics - If this option is ON,
TeleFinder/User will ask you if you would like to post a
message to a topic when you attempt to close the topic.  If this
option is OFF, you will not be prompted.

Alert me that my mail has been sent - If this option is ON, an
alert will be displayed after an e-mail message has been sent.
Otherwise no alert is shown.

The “Views” panel allows you to customize how items are
displayed in TeleFinder windows.  For windows that display
BBS files, you can select the font and font size.  Items will be
normally be shown in black text and plain style.

You can how new items are displayed by choosing the style
attributes and the color for new items.  The default is to display
new items in bold text.
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The “Online Chat” panel allows you to customize TeleFinder/
User’s chat windows.  These settings apply to multi-user chat,
chat with sysop, and instant messages.

The “Chat Input Text” section allows you to specify the text
characteristics of the chat window input area.  This is where you
type your messages.  You can specify the font, size, style, and
color.

The “Chat Logging” section allows you to specify if chat
messages will be logged to a text file.  You can specify the name
of the file and whether the file is ASCII text, or tab delimited.  A
tab delimited file will have the format of the name, followed by a
tab, followed by the message text.  The log file will be placed in
the same folder as TeleFinder/User.

The “Background” section allows you to customize the
background color for chat windows.  The default is white.  If this
is changed to a dark color, it is important to also change the text
color of all the chat user profiles to use lighter text colors for the
messages.  See the section “Chat User Profiles” for details.
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The “Desktop” panel is only necessary for Macs that do not have
Macintosh Drag & Drop software installed.  System 7.5 and later
include Macintosh Drag & Drop built in.  Without Macintosh
Drag & Drop, TeleFinder must create its own desktop, that
works similarly to the Finder, but is separate.

The first option, “Use full screen for TeleFinder desktop”
specifies how TeleFinder will display its desktop.  If this option
is ON, TeleFinder/User will display its own desktop using the
whole screen, like the Finder.  If this option is OFF, TeleFinder
will display its desktop in a separate window.

The second option, “Desktop items placement” allows you to
specify how Finder icons are arranged on TeleFinder’s desktop.
Icons can be arranged where Finder puts them, on the right side
of the screen, or left in their volume windows.
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Other Connection MethodsOther Connection MethodsOther Connection MethodsOther Connection MethodsOther Connection Methods
TeleFinder/User supports TCP/IP, Direct Serial, and
Connection Tool connection in addition to modem connections.
This section discusses the settings for these other connection
methods.

TCP/IPTCP/IPTCP/IPTCP/IPTCP/IP
Use the TCP/IP connection method when you want connect to a
BBS over the Internet or an internal TCP/IP network.  You need
to have MacTCP or Open Transport installed on your system to
be able to use this connection method. To use the TCP/IP
Connection Method follow these steps:

• Select MacTCP or Open Transport TCP/IP ␣ from TeleFinder’s
Connection Method menu.  If Open Transport TCP/IP is
unavailable, the choice will be grayed out.  This brings up the
TCP/IP Connection Configuration dialog.

• Enter 1474 in the Port Number text box.  All TeleFinder BBSes
should communicate on  port 1474 whenever possible.  If the
BBS you want to connect to uses a different port number, enter
that number here in place of 1474.

• Click in the OK␣ button to save the configuration.

Direct SerialDirect SerialDirect SerialDirect SerialDirect Serial
You can use this method to access a BBS for testing through a
serial cable.  With a “null modem”␣ cable you can connect the
Macintosh Modem port to the Printer port and logon to the BBS
from the same Macintosh it is running on.

To use the Direct Serial Connection Method follow these steps:
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• Select Direct Serial from TeleFinder’s Connection
Method menu.  This brings up the Serial Configuration
dialog.

• Select the port the null modem cable is connected to
from the Ports list.

• Select 57.6K␣ from the Baud Rate pop-up menu.

• Click in the OK button to save the configuration.

Note: A “Mac II␣ to ImageWriter”␣ cable works well as a
null modem cable.

Connection ToolsConnection ToolsConnection ToolsConnection ToolsConnection Tools
Connection Tools are a component of the Macintosh
Communications Toolbox.  They provide a convenient way of
using a diverse array of communications devices.  There are
Connection Tools to support connections over an AppleTalk
network,  Modems, and ISDN.

The following examples show how to use two common tools, the
AppleTalk ADSP Tool  (AppleTalk)␣ and the Planet ISDN␣ Tool
(ISDN).

To use a Connection Tool follow these steps:

• Select “Connection Tool” from TeleFinder’s Connection
Method menu.  This brings up the Connection Settings dialog.
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• Choose the specific Connection Tool you want to use from the
“Method”␣ pop-up menu.  This displays the options for that tool.

• Select the appropriate settings from the options dialog here.

AppleTalk ADSP Tool SetupAppleTalk ADSP Tool SetupAppleTalk ADSP Tool SetupAppleTalk ADSP Tool SetupAppleTalk ADSP Tool Setup

When using the AppleTalk ADSP Tool select these options:

•␣ Select the BBS you want to connect to from the
“Remote”␣ list.

• The “Connection Type” text box should always
contain ‘ADSP’.

• Click in the OK␣ button to save the AppleTalk ADSP
settings.

Planet ISDN SetupPlanet ISDN SetupPlanet ISDN SetupPlanet ISDN SetupPlanet ISDN Setup
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When using the Planet ISDN Tool it is important to select a
compatible “Protocol Profile” and “Rate Adaption.”  Users in the
United States should:

• Select the “X.25 - 64K” profile.

• Turn “56K Rate Adaption” on.

European and Japanese users also need to use the same protocol
profile when accepting calls or placing calls with the United
States.  Otherwise the 56K rate adaption may be left off.

Click in the OK button to save the Planet settings


